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Version history 

Version Date Description 

1.0 06/2015 Initial release. 
1.1 01/2022 Introduction of vector tiles and GeoPackage formats to the product. 

Formatting updates to the document. 
 

Purpose of this document 

This document provides information about and insight into the OS MasterMap Water Network Layer 
product and its potential applications. For information on the contents and structure of OS MasterMap 
Water Network Layer, please refer to the Overview and Technical Specification. 

The terms and conditions on which OS MasterMap Water Network Layer is made available to you and 
your organisation are contained in that Ordnance Survey customer contract. Please ensure your 
organisation has signed a valid current customer contract to be able to use OS MasterMap Water Network 
Layer. 

We may change the information in this document at any time, giving you the notice period set out in your 
contract. We do not accept responsibility for the content of any third-party websites referenced or 
accessed in or through this document. 

This document has been screened according to Ordnance Survey's Equality Scheme. If you have difficulty 
reading this information in its current format and would like to find out how to access it in a different 
format (braille, large print, computer disk or in another language), please contact us on: 
+44 (0)3456 05 05 05. 

Copyright in this document 

© Ordnance Survey Limited 2022. This document (including for the avoidance of doubt, any mapping 
images reproduced within it) is protected by copyright and apart from the rights expressly granted within 
this document to use the content, all rights are reserved. Any part of this document may be copied for use 
internally in your organisation or business so that you can use OS MasterMap Water Network Layer under 
the terms of your licence (but not otherwise). 

No part of this document may be reproduced or transmitted in any form or by any means (including 
electronically) for commercial exploitation, onward sale or as free promotional material without getting the 
written consent of Ordnance Survey beforehand. 

Trademarks 

Ordnance Survey, OS, the OS Logos, OS MasterMap, OS Terrain, OS MasterMap Highways Network and 
TOID are registered trademarks, and OS MasterMap Water Network Layer is a trademark of Ordnance 
Survey, Britain’s mapping agency. 

Contact details 

OS website ‘Contact us’ page (https://www.ordnancesurvey.co.uk/contact-us).  

https://www.ordnancesurvey.co.uk/contact-us
https://www.ordnancesurvey.co.uk/contact-us
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1. Introduction to the product 
OS MasterMap Water Network Layer is a digital representation of the watercourses in Great Britain as a 
series of connected features. The data represents the approximate central alignment of watercourses and is 
attributed to provide a range of information about the section of watercourses they represent. 

The product has two core feature types: 

• WatercourseLink: A WatercourseLink feature represents the alignment of a watercourse. The 
majority have been derived from Ordnance Survey detailed topographic data, made available to 
customers as the OS MasterMap Topography Layer product (http://os.uk/topo). 

• HydroNode: A HydroNode feature explicitly represents the start, junctions and end of each 
watercourse, as well as places where there's a change in the real-world-related attribution. 

Figure 1: Example extract from OS MasterMap Water Network Layer showing WatercourseLink and HydroNode features. 

 

http://os.uk/topo
http://os.uk/topo
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2. Product applications 
OS MasterMap Water Network Layer supports a wide range of customers’ applications. The product can 
be used alone or in combination with other Ordnance Survey products, such as OS MasterMap 
Topography Layer, OS MasterMap Imagery Layer and OS Terrain 5. It will significantly enhance systems 
used to manage waterways and rivers and the flood risk they pose. 

The OS MasterMap Water Network Layer product can be used for applications such as: 

• Understanding flood risk 

• Flood risk mitigation planning 

• Flood response planning and execution 

• Detailed flood modelling for insurance and land and property 

• Environmental impact analysis 

• Tracking water flows and any contamination 

• Asset management and protection 

• The management of statutory directives relating to watercourses 

• Ecology studies, for example, species migration 

• Analytics and visual interpretation, particularly when used in combination with other Ordnance Survey 
products, for example, OS Terrain 5 
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3. Requirements for using the data 

3.1 System requirements 

OS MasterMap Water Network Layer is designed for use in a geographic information system (GIS). For 
details of Ordnance Survey’s Licensed Partners who can assist you with incorporating the product in their 
systems, please see the 'Software for mapping' page on the Ordnance Survey website 
(https://www.ordnancesurvey.co.uk/business-government/tools-support/gis/software). 

Ordnance Survey does not recommend specific suppliers or software products, as the most appropriate 
system will depend on many factors, for example, the amount of data being taken, resources available 
within the organisation, the existing and planned information technology infrastructure, and, ultimately, the 
applications that the data will be used for. However, as a minimum, the following elements will be required 
in any system: 

• A means of reading the data, either in its native format, or by translating it into a file format or for 
storage in a database. 

• A means of storing and distributing the data, perhaps in a database or through a web-based service. 

• A way of visualising and / or querying the data, typically a GIS. 

3.2 Backup provision of the product 

You are advised to copy the supplied data to a backup medium before following the steps outlined in this 
getting started guide. 

3.3 Typical data volumes 

For reading purposes, it is recommended that users store the data on a single hard disc. This will speed up 
the ability of your computer to read the data. Compressed file sizes for the full supply of England, Scotland 
and Wales are as follows: 

• Geography Markup Language (GML): The compressed file size for Great Britain is approximately 
1.25Gb. 

• GeoPackage: The compressed file size for Great Britain is approximately 1.8Gb. 

• Vector tiles: The compressed file size for Great Britain is approximately 1.5Gb. 

https://www.ordnancesurvey.co.uk/business-government/tools-support/gis/software
https://www.ordnancesurvey.co.uk/business-government/tools-support/gis/software
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4. Structure of the supplied data 

4.1 Data structure 

OS MasterMap Water Network Layer is supplied in three formats: Geography Markup Language 
(GML 3.2.1), GeoPackage and vector tiles. All formats are compressed into a regular zip file (.ZIP). 

Before loading the data, you will need to unzip it by using any of the regular zip programs available or via 
the facility within the Windows 10 operating system. 

4.2 Area of interest order type 

Tiled dataset will be provided in 5 x 5km square tiles and will contain all features present in the tile(s) 
ordered. 

The data is supplied as 'hairy tiles', in that no feature is broken at the tile edge but is included across the tile 
boundary if it extends into an adjacent tile. As such, a data holding comprising more than one 5km2 tile will 
contain duplicate features which may need to be removed depending upon the user requirement. 

The GeoPackage and vector tiles formats will be available for Great Britain coverage only. 

The file naming convention will be as follows: 

• GML: 5km2 tile ID. gz, for example: HP4500.gz 
• GeoPackage: MMNWGB.gpkg 
• Vector tiles: MMNWGB.mbtiles 

4.3 Data ordering and download 

• Direct customers and Partners, please contact your account manager or Business Enquiries. 

• For PSGA customers, the product is available to you through the PSGA contract. 

The data is available as an online download via the OS Data Hub (https://osdatahub.os.uk/).  

4.4 Download contents 

The data is supplied in a .zip archive, which contains a parent folder with two sub-folders entitled DATA 
and DOC, and an additional readme file. 

Sub-folder Contents 
DATA  (Zipped files) 
DOC  Disc_contents.txt  
  Licence.txt 
-------------------------------------------- 
readme.txt 

https://osdatahub.os.uk/
https://osdatahub.os.uk/
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5. Loading the data (GML format) into a GIS 
Geography Markup Language (GML) is an XML dialect, which can be used to model geographic features. It 
was designed by the Open Geospatial Consortium (OGC) as a means for people to share information 
regardless of the particular applications or technology that they use. In the first instance, GML was used to 
overcome the differences between different geographic information system (GIS) applications by providing 
a neutral file format as an alternative to proprietary formats. 

The data can be loaded into several GIS. This section describes how to translate the GML and load it into 
some commonly used GIS. For more information about other GIS that OS MasterMap Water Network 
Layer is compatible with, please speak to your Relationship Manager. 

The common software covered in this section are as follows: 

• QGIS 
• FME 
• ERSI ArcMap 
• MapInfo Professional 
• Cadcorp Map Modeller 

5.1 QGIS 

The following step-by-step instructions outline how to load OS MasterMap Water Network Layer into 
QGIS using the GML file(s) you have received. They have been prepared using version 3.16.7 of QGIS 
Desktop – an open-source GIS in which you can create, edit and visualise and publish geographic 
information. You can download QGIS for free from the 'Download QGIS for your platform' page of the 
QGIS website (http://www.qgis.org/en/site/forusers/download.html). 

5.1.1 Loading OS MasterMap Water Network Layer GML into QGIS 

1. Launch QGIS. 

2. OS MasterMap Water Network Layer data can be loaded into QGIS either zipped or unzipped. To load 
the data, click on Add Vector Layer button from the left-hand toolbar. 

 

https://www.qgis.org/en/site/forusers/download.html
https://www.qgis.org/en/site/forusers/download.html
http://www.qgis.org/en/site/forusers/download.html
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3. The Data Source Manager dialog box will open. In the Source section, click on the […] button to the 
right of the Vector Dataset(s) field and navigate to the GZ or GML file you wish to import. 

 

4. When you've selected the file you wish to import, click Add. 

 

Note: Alternatively, you can load the file by dragging and dropping the GZ or GML file into a blank canvas. 
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5. This will open a Select Vector Layers to Add… dialog box in which you can select the layer(s) you wish 
to add to the GIS. If you wish to add both water layers (i.e. HydroNode and WatercourseLink), click 
Select All. Confirm your choice by clicking OK: 

 

6. The HydroNode and WatercourseLink layers will be added to the canvas in the main map window. 

 

7. You can add additional layers of OS MasterMap (for example, OS MasterMap Topography Layer) to 
give context to OS MasterMap Water Network Layer data. 
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5.1.2 Exporting OS MasterMap Water Network Layer to different GIS formats using 
QGIS 

You can also use QGIS to export OS MasterMap Water Network Layer data into many different common 
GIS formats. This will allow you to open the files in many other GIS applications. 

1. Right click on the layer you want to translate, then select Export and Save Feature As… 

Note: If you are trying to save layers for more tiles or a national dataset, you will have to save them separately as 
there is no option for grouping layers. 

2. In the Save Vector Layer as… dialog box that opens, use the dropdown arrow in the Format field to 
select your chosen format for further analysis, for example, MapInfo TAB or ESRI Shapefile. 

3. Click on the Browse button to save your file to a location of your choice. 

4. Click OK to save the data in your chosen format. 
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5.2 FME 

The following section details how to load OS MasterMap Water Network Layer into FME using the GML 
file you have received. Doing so will allow you to view the data and then translate it into the most 
appropriate format for your software. The step-by-step instructions have been prepared using FME 2019.1. 

5.2.1 Viewing and translating data in FME 

1. Open FME Workbench and select New in the Getting Started box. 

2. Click the Add Reader button from the main toolbar to add a Reader. 

 

3. In the Add Reader dialog box that opens, select GML (Geography Markup Language) from the dropdown 
list for Format. 

4. Use the Browse […] button next to the Dataset field to navigate to your files and select them. 

5. Leave the Parameters… as default and the Workflow Options as Individual Feature Types. 

6. Select OK to add the Reader. 
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7. Once the Reader has been added successfully, the log window will display the text 'Mapping File 
Generation was SUCCESSFUL' and the Select Feature Types dialog box will open. 

Note: If FME cannot find the appropriate schema file for use in translation, the OS MasterMap Water Network 
Layer XML schema v1 file (http://www.os.uk/xml/schema/waternetwork/v1/index.html) can be downloaded from the 
schema repository on the OS website. 

8. In the Select Feature Types dialog box, select the feature types that you wish to translate from the list 
or use the Select All option to add all objects. 

Note: OS MasterMap Water Network Layer currently only contains the feature types of WatercourseLink and 
HydroNode. FME will give you additional feature type options inherited from INSPIRE. 

9. Click OK. 

 

10. OS MasterMap Water Network Layer objects will have been added to the canvas. 

 

https://www.ordnancesurvey.co.uk/xml/schema/waternetwork/v1/index.html
https://www.ordnancesurvey.co.uk/xml/schema/waternetwork/v1/index.html
http://www.os.uk/xml/schema/waternetwork/v1/index.html
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5.2.2 Viewing the data using FME Data Inspector before translation 

Before translating the data, FME allows you to view the data. The viewing process is faster than translation 
and allows you to quickly interrogate the data before you start translating it. 

1. Highlight all of the feature types you wish to view by either selecting them individually or drawing a box 
around them. 

2. Right-click on one of the feature types and select Connect Inspectors. 

 

3. Run the workspace (click the Run button on the main toolbar) with the Inspectors connected in order 
to view the data in FME Data Inspector. 
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4. When finished, the two layers of OS MasterMap Water Network Layer will be viewable in the Visual 
Preview window. You can open this window in a separate FME Data Inspector window by clicking the 
FME Data Inspector button. 

 

5.2.3 Translating GML in FME 

You can use FME to translate the files from GML to any other format supported by FME (for example, 
TAB, SHP, GPKG or a spatial database). 

1. In the main FME window, remove the Inspectors you have connected if you have chosen to use FME 
Data Inspector to view and interrogate the data. You can do this by clicking and deleting each Inspector 
separately or by selecting all of them and deleting them together. 

2. Click on the Add Writer button from the main toolbar. 
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3. In the Add Writer dialog box that opens, select the format you are translating into from the dropdown 
list for Format, for example, OGC GeoPackage or File GeoDatabase. 

4. Use the Browse […] button next to the Dataset field to navigate to the folder where you want to save 
the translated data. 

5. Leave the Parameters… set to default. 

6. Under the Add Feature Type(s) section, set Table Definition to Copy from Reader. This will enable the 
new Writer to inherit the schema of the Reader feature types. 

7. Click OK to add the Writer. 

 

8. A Select Feature Type dialog box will appear prompting you to select which existing feature type(s) to 
copy. Select both the WatercourseLink and HydroNode feature types, then click OK. 
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9. The Writer feature types will now be added to the canvas. The new Writer feature types will have 
inherited the schema of the Reader feature types. 

 

10. Connect the Readers to the Writers by dragging the triangle on the Reader and connecting it to the 
red triangle on the corresponding Writer. 
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11. Once the workspace has been set up, run the translation by clicking the Run Translation button. 

Note: This is a basic translation of the data, and within FME workbench you could manipulate the data further if 
needed. However, you can use the software just as a translator and open the data in other GIS software for analysis. 
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5.3 ESRI ArcMap 

The following step-by-step instructions outline how to load OS MasterMap Water Network Layer GML 
data into ESRI ArcMap. The instructions were prepared using ESRI ArcMap version 10.6.1. 

GML data can be now imported as zipped GML (GZ) directly into ESRI ArcMap using the Data 
Interoperability extension called Quick Import. The Data Interoperability extension is now available at no 
cost as a part of ArcMap from version 10.2. You will require Internet access when using the Quick Import 
tool so that the data can access the schema attached to the file. 

Note: If your version of ArcMap is older than 10.2 and you do not have a licence for Data Interoperability, you will 
have to use translation tools available in QGIS or FME (explained in Section 5.1 and Section 5.2, respectively) to first 
translate the GML data into ESRI shapefiles, before you can load them in ArcMap. Please go to Section 5.3.2 for 
instructions on loading translated GML into ESRI ArcMap. 

You can find more information about Quick Import on the ArcGIS Data Interoperability page of the ESRI 
website (https://www.esri.com/en-us/arcgis/products/arcgis-data-interoperability/overview). 

5.3.1 Loading OS MasterMap Water Network Layer GML into ESRI ArcMap 

1. Launch ArcMap. 

2. Click on the ArcToolbox window button in the main toolbar. 

 

3. In the ArcToolbox window that opens, click on the plus sign next to Data Interoperability Tools, then 
double-click on Quick Import. 

 

https://www.esri.com/en-us/arcgis/products/arcgis-data-interoperability/overview
https://www.esri.com/en-us/arcgis/products/arcgis-data-interoperability/overview
https://www.esri.com/en-us/arcgis/products/arcgis-data-interoperability/overview
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4. In the Quick Import dialog box that opens, click on the […] button next to the Input Dataset field. 

 

5. In the Specify Data Source dialog box that opens, click on the dropdown arrow in the Format field and 
select More Formats. 

 

6. In the FME Reader Gallery dialog box that opens, select GML SF-0 (Geography Markup Language Simple 
Features Level SF-0 Profile) from the list of options, then click OK. 
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7. Back in the Specify Data Source dialog box, use the […] button next to the Dataset field to navigate to 
the folder where you saved your GZ file; select the folder and click Open. Make sure that extensions 
available to load are *.gz / *.gml. 

8. Leave the rest of the settings as default and click OK. 

 

9. Back in the Quick Import dialog box, click on the folder button to the right of the Output Staging 
Geodatabase field. 
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10. In the Output Staging Geodatabase dialog box that opens, navigate to the correct folder and select the 
output geodatabase for the feature classes to be stored in. 

11. Select Geodatabases from the dropdown options for Save as type. 

12. Click Save. 

 

13. Once you have made your selections for the Input Dataset and Output Staging Geodatabase fields, you 
can click OK at the bottom of the Quick Import dialog box. 

 

14. As soon as the import process has started, you will see a process running notification at the bottom of 
your screen. When the import process has successfully completed, the following popup window should 
appear in the bottom right-hand corner of your screen: 
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5.3.2 Loading translated GML into ESRI ArcMap 

If your version of ArcMap is older than version 10 or if you do not have access to the Quick Import (Data 
Interoperability) extension, you will have to use the translation tools available in QGIS or FME (explained in 
Section 5.1 and Section 5.2, respectively) to translate the GML data into ESRI shapefiles first, before you 
can load them into ArcMap. 

Note: The following instructions were prepared using ESRI ArcMap version 10.6.1. 

1. Launch ArcMap. 

2. To load a shapefile into ArcMap, click on the Add Data button in the main toolbar. 

 

3. In the Add Data dialog box that opens, click the Connect To Folder button. 
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4. In the Connect To Folder dialog box, navigate to the folder where you saved your translated 
OS MasterMap Water Network Layer data, then click OK. 

 

5. Back in the Add Data dialog box, select the WatercourseLink and HydroNode shapefiles that will now be 
in the list of options, then click Add. 

 

6. The two OS MasterMap Water Network Layer features should now have loaded into the map window 
of ArcMap. 
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5.4 MapInfo Professional 

The following instructions outline how to load OS MasterMap Water Network Layer GML into MapInfo 
Professional. They have been prepared using version 12.5 of MapInfo. This new version of MapInfo allows 
you to convert GML data using a tool called Universal Translator. 

Note: These instructions refer to the 64Bit version. The Universal Translator window is the same in the 32Bit version; 
however, the MapInfo menus are slightly different. 

If your version of MapInfo is 12.0.2 or older, you will have to use translation tools available in FME or QGIS 
to translate the GML data into MapInfo TAB before you can load the data into MapInfo. If you are bringing 
in already translated TAB files, please see Section 5.4.2 on 'Loading translated GML files into MapInfo'. 

5.4.1 Translating GML into MapInfo Professional 

1. Open MapInfo Professional. 

2. On the main toolbar, select Tools > Universal Translator > Universal Translator. 
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3. In the FME Quick Translator dialog box that opens, select File > Translate or click on the Translate data 
button. 

 

4. The Set Translation Parameters dialog box will open. In the Reader section, click on the dropdown 
button next to Format. 
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5. The Reader Gallery dialog box will open. Select GML (Geography Markup Language) from the list of 
options, then click OK. 

 

6. In the Reader section within the Set Translation Parameters dialog box, navigate to the folder where 
you saved your GML files under the Dataset option. A Select 'File' dialog box will appear. Once you've 
located the folder and selected it, click OK. 

 

7. In the Writer section within the Set Translation Parameters dialog box, click on the dropdown button 
next to Format and select MapInfo TAB. 

8. Again in the Writer section, within the Dataset option, navigate to the folder where you want your 
TAB file to be saved. 

9. You can leave the rest of the settings as default. 
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10. Click OK. 

 

11. The translation will start. You will notice commands appearing in the FME Quick Translator dialog box. 

12. When the translation has completed, you will see a line of text saying: ‘Translation was SUCCESSFUL’. 
Close the FME Quick Translator dialog box. 

 

13. The GML files will have been successfully translated into MapInfo TAB files. 
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5.4.2 Loading translated GML files into MapInfo Professional 

1. Open MapInfo Professional. 

2. To load translated files, select Home > Open on the main toolbar. 

 

3. The Open dialog box will open. In the Look in option, navigate to the folder where you saved your 
TAB files. 

4. If you don’t see your files, select MapInfo (*.tab) from the Files of type dropdown menu. 

5. Select WatercourseLink and HydroNode, then click Open. 
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6. The data will now load into MapInfo. 

 

7. To add the Layers window, right-click in the main window and select Layer Control. This will display the 
two OS MasterMap Water Network Layer objects that you have loaded: WatercourseLink and 
HydroNode. 
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5.5 Cadcorp SIS Map Modeller 

The following instructions outline how to load OS MasterMap Water Network Layer GML into Cadcorp 
SIS Map Modeller. They have been prepared using Cadcorp SIS Map Modeller version 8.0 (x64). 

5.5.1 Translating GML using Cadcorp SIS Map Modeller 

1. Launch Cadcorp SIS Map Modeller. 

2. Select the Home tab on main menu toolbar, then click the Add Overlay button. 

 

3. In the Overlay Types dialog box that opens, select Files > File > Next. 
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4. This will open the File Browser dialog box. Navigate to the folder you have saved the GML data in. 

 

5. In the bottom right-hand corner of the File Browser dialog box, change the files from All files (*.*) to 
Ordnance Survey (GB) MasterMap layer (*.gml, *.gz). 
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6. Back in the File Browser dialog box, select the file(s) and click Finish. 

 

7. OS MasterMap Water Network Layer features will have been added to the main map window. 
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6. Loading the data (GeoPackage and vector tiles 
formats) into a GIS 

This getting started guide focuses solely on using the product in GML format. For guidance on using the 
product in GeoPackage or vector tiles formats, please see the following two getting started guides, which 
are available on the Ordnance Survey website: 

• Getting Started with GeoPackage guide (https://www.ordnancesurvey.co.uk/documents/getting-started-
with-geopackage.pdf) 

• Getting Started with Vector Tiles guide (https://www.ordnancesurvey.co.uk/documents/user-
guides/getting-started-with-vector-tiles-v1.0.pdf) 

https://www.ordnancesurvey.co.uk/documents/getting-started-with-geopackage.pdf
https://www.ordnancesurvey.co.uk/documents/getting-started-with-geopackage.pdf
https://www.ordnancesurvey.co.uk/documents/getting-started-with-geopackage.pdf
https://www.ordnancesurvey.co.uk/documents/user-guides/getting-started-with-vector-tiles-v1.0.pdf
https://www.ordnancesurvey.co.uk/documents/user-guides/getting-started-with-vector-tiles-v1.0.pdf
https://www.ordnancesurvey.co.uk/documents/user-guides/getting-started-with-vector-tiles-v1.0.pdf
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7. Creating a water network using ESRI software 
The OS MasterMap Water Network Layer data can be used in two types of networks. 

Geometric network 

Geometric networks offer a way to model common networks and infrastructures found in the real world. 
Water distribution and water flow in a stream are two examples of resource flows that can be modelled 
and analysed using a geometric network. 

A geometric network can be set up easily, does not need additional license and has some functionality 
(tracing up / down stream, for example) provided by the Utility Network Analyst Toolbar. 

Note: A geometric network cannot be published in ArcGIS server. 

Network analyst 

Network analyst is the mathematical processing of the geometry of a link / node layer, enabling the 
identification of all possible routes around that network, along with the distances and times involved. Put 
simply, this means that, using an accurate road data layer, the computer can identify possible routes 
between two locations and calculate the shortest route. 

This requires a Network Analyst License. You can build simple networks, but more complicated networks 
will require you to have detailed knowledge of networks to set up attributes and elevators. 

Note: This guide will only cover a geometric network. 

7.1 Building a geometric network 

A geometric network is built within a feature dataset in the geodatabase (see Section 5.3). The feature 
classes in the feature dataset are used as the data sources for network junctions and edges. The following 
step-by-step instructions will guide you through building a geometric network; they have been prepared 
using ArcMap version 10.6.1. 

1. Open ArcCatalog. 

2. Navigate to your geodatabase in your Folder Connections. 

3. Expand the geodatabase. 
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4. Right-click on the geodatabase, select New from the list of options, then click Feature Dataset… 
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5. Give your new Feature Dataset a name, then click Next. 

 

6. Set your coordinate system that will be used for the XY coordinates in the data (British National Grid 
EPSG:27700), then click Next. 
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7. Set your coordinate system that will be used for the Z coordinates in the data (Newlyn). Ordnance 
Datum Newlyn (ODN) is our national coordinate system for heights above mean sea level (orthometric 
heights). 

8. Click Next. 

 

9. In the next panel, leave your XY tolerance as the default settings and click Finish. A new Feature 
Dataset will appear in the geodatabase. 

 

10. Copy the HydroNode and WatercourseLink feature classes into the new Feature Dataset by simply 
dragging them in. 
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11. You may get an error message if the coordinate systems of the feature classes don’t match those of the 
new Feature Dataset. To resolve this, right-click on each feature class and select Properties. Check that 
the Z coordinate system is set to Newlyn and the XY coordinate system is set to British National Grid, 
then copy the feature classes into the new Feature Dataset. 

 

12. Right-click the Water feature dataset in the geodatabase, select New from the list of options, then click 
Geometric Network… 
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13. Click Next in the New Geometric Network dialog box that opens. 

 

14. Type the name of your geometric network into the text box under the Enter a name for your 
geometric network section. 

15. Select Yes for the snap features within specified tolerance option. 

16. Type 0.5 in the text box next to Meters. 

17. Click Next. 
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18. In the next panel, you must select which feature classes in the feature dataset will participate in the 
geometric network. Click Select All. All the feature classes in the list will participate in the network. 

19. Click Next. 

 

20. The option to exclude features with certain attributes makes it easier to manage the network. In the 
next panel, you need to opt not to exclude features. Click No, so that all features will participate in the 
geometric network. 

21. Click Next. 

 

22. In the next dialog box, you must specify which line classes will become complex edge feature classes in 
the geometric network. Complex edge features are not split into two features by the connection of 
another feature along their length; thus, they are useful for modeling water mains, which may have 
multiple laterals connected to them. By default, all line feature classes are simple edge feature classes. In 



OS MASTERMAP WATER NETWORK LAYER – GETTING STARTED GUIDE 
January 2022 

 

OFFICIAL 
© Ordnance Survey Ltd 2022 Page 42 of 44 
 

the same dialog box, you must specify which, if any, of the junction feature classes can act as sources 
and sinks in the network. Sources and sinks are used to determine the flow direction in the network. 

23. In the row for the HydroNode feature class, click Simple Junction under the Role column. 

24. In the row for the WatercourseLink feature class, choose Complex Edge from the list under the Role 
column. 

25. In the row for the HydroNode feature class, click the dropdown menu under the Sources & Sinks 
column, then click Yes. 

26. Click Next. 

 

27. This geometric network does not require weights, which is the default, so click Next in the following 
panel: 

 

28. Clicking Next opens a summary page. Click Finish after you review the summary page. 
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29. A progress indicator will appear displaying the progress for each stage of the network-building process. 
You will receive an error message indicating that the network has been built but contains some errors: 

 

30. Click OK to close the error message box. 

31. You can see what errors occurred while building the geometric network by previewing the 
WaterNet_BUILDERR table. 

32. Right-click the WaterNet_BUILDERR table in the Catalog and click Item Description. Then click the Preview 
tab to view the entries in this table. 

33. Features with invalid geometries are identified during the network build progress and recorded in the 
Network Build Errors Table. (This is user-managed; it does not get updated when the features listed 
within it are edited.) 

34. If you received more than two errors, delete the geometric network and repeat the steps to create it 
again. 

35. You can then proceed to load the data into ArcMap. 
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Annex A: Product support links 
• Further information about the product can be found on the OS MasterMap Water Network Layer 

product page on the OS website (http://os.uk/waternetwork). 

• OS MasterMap Water Network Layer Overview (https://www.ordnancesurvey.co.uk/business-
government/tools-support/mastermap-water-support). 

• OS MasterMap Water Network Layer Technical Specification 
(https://www.ordnancesurvey.co.uk/business-government/tools-support/mastermap-water-support) 

Loading the data (GeoPackage format) 

The product's Getting Started Guide focuses solely on using the product in Geography Markup Language 
(GML) format. For guidance on using the product in GeoPackage format, please see the Getting Started 
with GeoPackage guide (https://www.ordnancesurvey.co.uk/documents/getting-started-with-
geopackage.pdf), which is available on the OS website. 

Loading the data (vector tiles format) 

The product's Getting Started Guide focuses solely on using the product in GML format. For guidance on 
using the product in vector tiles format, please see the Getting Started with Vector Tiles guide 
(https://www.ordnancesurvey.co.uk/documents/user-guides/getting-started-with-vector-tiles-v1.0.pdf), 
which is available on the OS website. 

http://os.uk/waternetwork
http://os.uk/waternetwork
http://os.uk/waternetwork
https://www.ordnancesurvey.co.uk/business-government/tools-support/mastermap-water-support
https://www.ordnancesurvey.co.uk/business-government/tools-support/mastermap-water-support
https://www.ordnancesurvey.co.uk/business-government/tools-support/mastermap-water-support
https://www.ordnancesurvey.co.uk/business-government/tools-support/mastermap-water-support
https://www.ordnancesurvey.co.uk/business-government/tools-support/mastermap-water-support
https://www.ordnancesurvey.co.uk/documents/getting-started-with-geopackage.pdf
https://www.ordnancesurvey.co.uk/documents/getting-started-with-geopackage.pdf
https://www.ordnancesurvey.co.uk/documents/getting-started-with-geopackage.pdf
https://www.ordnancesurvey.co.uk/documents/getting-started-with-geopackage.pdf
https://www.ordnancesurvey.co.uk/documents/user-guides/getting-started-with-vector-tiles-v1.0.pdf
https://www.ordnancesurvey.co.uk/documents/user-guides/getting-started-with-vector-tiles-v1.0.pdf
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